Table of Contents:
Getting Started: 2
Installation: 2
Connecting the Instrument: 3
Create and Modify Testing Plans: 4
Add or Modify Channels: 10
Download Data: 11
Reports: 12
Designing a Hygiene Testing Program: 15
Main Screen: 17
Report File Features: 19
Archiving Data: 22
Additional Features: 23
Troubleshooting: 25
Charm Sciences’ Contact Information: 28
Appendix A: Using an instrument without using plans: 29
Appendix B: Using novaLINK over a network: 30

Introduction:
The novaLINK program is a software package designed as part of Giene Technology, to develop testing programs and facilitate data management for the novaLUM® luminometer.

Charm® novaLINK has simple and intuitive screen layouts and user-friendly popup menus, used to develop testing locations related by a combination of surface type, test groups (plans), and/or test channels. One touch downloading with report query and Microsoft® Excel® spreadsheet/graphics simplify data management and analysis. Text editing and one-touch uploading simplify maintenance and flexibility of testing programs. This innovative and fully customizable software tool combines speed and ease in both program setup and report management.

Charm novaLINK 2.0 is compatible only with novaLUM versions 1.04.19 and higher. Contact Charm Sciences for more information.

Charm, novaLUM, novaLINK, PocketSwab, AllerGiene, Giene Technology and WaterGiene are either registered trademarks or trademarks of Charm Sciences, Inc. in the U.S. and/or other countries. Microsoft, Windows and Excel are either registered trademarks or trademarks of Microsoft Corporation in the U.S. and/or other countries.
Getting Started:

How to set up novaLINK:
1. Organize Hygiene Testing Program.
2. Install novaLINK using the CD.
3. Connect and Synchronize instrument.
4. Create/Modify Plans.
5. Add/Modify database Surfaces, Locations and Limits.
6. Create/Modify Channels.
7. Download and/or erase novaLUM memory.
8. Upload Plans to instrument.
9. Calibrate channels. (See novaLUM manual for calibration procedures.)
11. Run Reports.

Installation:

A novaLINK installation CD is provided by Charm Sciences. The CD may or may not contain customized plans, locations and surfaces, depending upon purchase arrangements.

Required Hardware:
- Computer with Pentium CPU or higher (1000 mHz, 128MB RAM, 20MB hard drive space).
- CD-ROM for installation.
- Serial communications port or USB port.

System Requirements:
- Compatible with most Windows® 2000 or higher operating systems.
- Must have a working version of Microsoft Excel 2000 or higher on the C: drive.
- Screen resolution of 1280 by 1024 recommended.
- User must have administrative rights to install/set up novaLINK.

To Install novaLINK:
1. For network installation of the novaLINK program, see Appendix B for details. If performing an installation on a local computer only, proceed to step 2. If reinstalling novaLINK for any reason, please see step 12 before beginning.
2. Make sure that current user logged on has full administrative rights.
3. Close all open programs and place the CD in the computer's CD drive.
4. The Novalink InstallShield Wizard will pop up automatically. If wizard does not pop up, open the cd through “my computer,” and double click on “setup”.
5. Read, and scroll all the way through the Novalink Software License agreement, then click on the circle “I accept the terms in the license agreement,” then click “next”.
6. Select where the novaLINK program and database should be installed, then click “next”. The default installation location is C:/novalink. Localized Report files will always be installed under the local computer’s Program Files directory with a folder named “novaLINK Reports”.
7. Select “Typical” Setup to install a full version of novaLINK, then click “next”.
8. Click “Install.”
9. When prompted, plug in the USB Cord. Connect the small end of the cord into the bottom of the novaLUM, and turn the novaLUM on. (This next step will automatically install the drivers; Note that some operating systems will require selecting “Close” upon completion of driver install)
10. Click “Finish”.
11. Restart the computer and run novaLINK by using the shortcut created on the user’s desktop or...
12. Any time novaLINK is reinstalled on the original computer system, moved to a different computer, or the original computer has a system upgrade, Charm Sciences’ Technical Support should be contacted. It is vital that the files in the DbData folder remain constant from the initial install since this is where all customizations and data are stored.

**Connecting the Instrument:**

The novaLUM comes standard with two types of cables to be used for connection and synchronization. Either of these two cables may be used, but NOT to be used together at the same time.

- USB to USB-mini cable.
- Modular cable (black) with an RS232 9-pin serial port adapter.

**Connecting to a Serial Comport:**

1. Locate the Comport on the back of the computer. These ports are often marked with the symbol “|O|O|” or a notation of the port number.
2. Use the RS-232 9-pin adapter and attach to the Comport.
3. Connect one end of the modular cable to the adapter, and the other end to the novaLUM.

**Connecting to a USB port:**

1. Locate a free USB port directly on the back, side, or front of the computer.
2. Attach the larger-size end to the USB port and the USB mini end to the novaLUM.

1. Power on the attached novaLUM and allow it to go through its internal diagnostics and reach the Main Screen.
   - It is recommended to connect the novaLUM to AC power when connected to novaLINK, to prevent shutdown while an instrument update is in progress.
2. Open novaLINK by double-clicking on the novaLINK icon (located on the computer desktop or through Start/Program Files/novaLINK).
3. The screen at right will be displayed.

**Synchronizing with novaLINK:**

1. Click on the Connect and Synchronize button at the bottom of the Main Screen.
2. As the program and novaLUM connect, a Waiting for Connection icon will briefly appear in the center of the screen. Other buttons will be deactivated.
3. When connection is established, the Instrument Parameters and Instrument Status will appear on the screen, and the attached novaLUM will display a message indicating that it is under Remote Control.
If connection is not established in a few seconds:

- Make sure that the communications cable/adapter is connected properly to the novaLUM.
- Make sure that the novaLUM is turned on, and that the Novalum is on the "main menu" screen before clicking on "connect and synchronize."

Create and Modify Testing Plans:

- Access the Plans screens either through the Edit Menu or the Plan Icon on the Main Screen toolbar.
- This screen may be password protected. Type 'novalink', which is the default password.
- The instrument does not need to be attached to novaLINK when plans are created or edited.
- The instrument must be connected and updated after any changes are made to plans.
- To view a pre-existing plan, chose the plan name from the drop down list.
- View the selected plan’s contents in the spreadsheet view.
**Plan Screen Icons:**

- **Upload:** Transfers plans to the attached novaLUM.
- **Save:** Saves any changes made to new, existing or modified plans.
- **Print:** Creates a print out of selected plans.
- **Exit:** Exits plan screen.
- **Edit:** Allows direct access to edit locations or surfaces.
- **Sort Alphabetically:** When selected, sorts locations or surfaces in alphabetically order. Once activated icon will change to “Sort by ID”. When selected, ”Sort by ID” sorts locations or surfaces in the order that they were entered into the database. The default sort order is by ID, and this will reset each time that novaLINK is opened.
- **Limit:** The Location and Surface lists may also be sorted by Limit, in ascending or descending order. Click on the grey Limit header on the list to sort.
- **New Plan:** Blanks out all information so a new plan can be created.
- **Insert Row:** Inserts a row into an existing plan for a new location and surface.
- **Delete Row:** Deletes a row’s location and surface from an existing plan.

**To create a new plan:**

1. **Enter a Plan Name** in the top Plan Name line.
   - Names can be numbers, letters, and any of the following symbols: * / . ; # - + &
   - novaLINK will allow a maximum of 21 characters, however 16-19 will appear on the novaLUM display (depending on the screen selected).

2. **Select the appropriate Channel.** This channel type correlates to the type of assay. View the available channel types by clicking the arrow in the channel line.
   - The first channel is reserved for luminescence tests, such as the PocketSwab® Plus (LUM).
   - The second channel is reserved for AllerGiene® (AG).
   - The third channel is reserved for WaterGiene (H2OG).
   - Other channels may be set up for LUM, PasLite, Somatic Cells, Pesticide or F-AP/Chef. Go to the Main Menu/Edit Channels to modify channels.

3. In the Locations window at the left, use the scroll bar to **find the location** to be inserted into the plan. Double-click the location to copy it into the plan view.
   - Locations may also be dragged from the list to the plan view: select the destination for the location, and then select the location on the list. Place the mouse on the drag bar between limit column and scroll bar. A box will appear next to the mouse arrow. Click and drag the location to the plan view, then release.
   - If a new location needs to be created, type the new location in the plan view and then press Enter, or click on Edit button to enter the Locations screen (see Add or Modify Surfaces, Locations).
   - The location selection cursor will automatically move to the next blank location in the plan view on the right.

4. **Change the surface**, if the default surface is not correct.
   - The default surface appears with each location selection, and is set at the bottom left of the plan screen. This resets to the first listed surface each time novaLINK is opened.
   - To change the surface type, click on the surface in the location row to be changed. Then double-click on the desired surface from the Surfaces list.
   - Drag and drop a surface from the list to the plan view: select the destination for the surface, and then place the mouse on the drag bar between limit column and scroll bar. A box will appear next to the mouse arrow. Click and drag the surface to the plan view and release.
   - Create a new surface type by typing the new surface in the plan view and then pressing Enter, or click on Edit button to enter the Surfaces screen (see Add or Modify Surfaces, Locations).
5. Repeat steps 3 & 4 for each location in the plan.
6. On completion of the plan, check the plan name and then click Save; a message will appear confirming the creation of a new plan.
7. Click on the door icon to exit the plans screen.
   - Upon exiting the plan screen novalINK will ask, “Do you want to upload the edited/new plan(s) to unit?” If the novalUM is connected, select ‘Yes’. If not, and you want to upload plans at a later time, select ‘No’.
   - Saved Plans can be uploaded at any time by using the Upload button on the main novalINK toolbar. See Section Upload Plans to Instrument.

Tips when creating plans:

- To insert a location above an existing location in the plan, select the location and then click the Insert Row button. A blank row will appear above the original location. Double-click on the location to be inserted from the Locations window on the left, or type the new location in the blank space and then press Enter.
- Remove an existing location by selecting the location and clicking the Delete Row button.
- Select multiple consecutive locations from the list by holding shift key and using keyboard arrows. To select nonconsecutive locations hold the control key and use the mouse to highlight desired locations.
- Change a location by selecting the row on the plan field and double-clicking on a new location name on the Locations list.
- Create a new location or surface by typing the new item in the spreadsheet view and pressing the Enter key, or by clicking on the Edit button above the Locations or Surfaces list (see Add or Modify Surfaces, Locations).
- Lists of locations or surfaces may be copied from other documents or files and pasted into the plan view. The list must be arranged vertically, copied, and then pasted using CTR+V or right-click/paste. A message will appear for each location that does not already exist in the database as it is added. Note: select the appropriate default surface before pasting locations into the plan view, as it will be assigned to each new location!

Modify an existing plan:

1. Click on the plan name from the list created when the arrow in the Plan Name line is selected. The information for that plan should display on the spreadsheet.
2. Modify the channel, locations list or order and surfaces in the plan as desired (replace, add, insert or delete locations and/or surfaces).
3. Click Save Plan; a message will appear confirming that the name already exists and confirming intention to replace it.
4. Confirm by clicking Yes box or cancel by clicking No box. If No, save constructed plan as a new name by changing it in the Plan Name line.

Change an existing plan’s name:

1. Select the plan to be renamed.
2. Right-click on the plan name and select Rename Plan from the pop-up list.
3. Type the new plan name in the box and click Save.
Add or Modify Surfaces, Locations:

- Access the Surfaces or Locations setup screens either through the Edit Menu on the main screen or the Edit buttons on the Plan Screen.
- If password protected, the default password is “novalink”.
- The setup screens are divided into two lists, “Available” (everything in the database) and “Active” (those currently active in the attached instrument).

Surface/Location Screen Icons:
- **Clear**: This button will clear or erase the Active list field.
- **Update DB**: Adds entered locations/surfaces to the Available Locations database and makes these items available when creating Plans.
- **Unit Update**: If Plans are not going to be created, this button will transfer the Active list to the attached instrument. See Addendum A: Using an instrument without using plans.
- **Print Report**: Prints a report of all locations and surfaces in the database.
- **Statistics**: Generates a report of Locations up to a certain day with notation of if that Location has been tested or has not been tested.
- **Exit**: Exit current screen.

Add a new Surface or Location:
1. Click *Clear* button to empty Active list.
2. Type or Paste new Surfaces or Locations into the Active list.
   - Information may be copied from other documents (Word, spreadsheets, etc.) as long as the items are in a vertical column and each item is on its own line in the original document.
   - Locations may be up to 18 characters long, surfaces up to 15 characters long.
   - Location/surface names can be numbers, letters, and any of the following symbols: * / . ; # - + &
3. Click *Update DB* to add items to the database (displayed as the Available list).
4. Click on the location or surface row in Available list and then click twice on the Limit column to modify.
   - See "Designing a Hygiene Testing Program" for more information about Limits.
5. Click on the Exit icon to close the setup screen.

Modify a Surface, Location, or Limit:
1. Click on the row of the item to be changed in the Available list. Click again to obtain a cursor.
2. Make desired changes to name. Click on limit field to adjust the number.
   - See Designing a Hygiene Testing Program for more information on establishing limits.
3. Press Enter key.
4. Click on the Exit icon to close the setup screen.
5. Reload all plans so that the changes are visible on the instrument.
Location Statistics:

View Statistical Report for Location:

1. From the Main novalINK screen click edit, then click locations. Click on the Statistics button.
2. Search To screen: Pick the end date for the desired range (all data up to this day will be included in the analysis).
3. Select the desired view (non-tested, tested, or both).
   - The default view will include both tested and non-tested data.
4. Export data to Excel. Data will be displayed in the order that the Locations were added to the database.

Locations Not Tested:

Tested Locations:

All Locations:
Upload Plans to Instrument:

- Select the Upload button from the Main Screen toolbar or the Plans screen.
- **Plans must be reloaded after any changes are made.**
- The screen is divided into two lists, Available Plans and Active Plans. The Available Plans list (on the left side) includes all plans in the database, and the Active Plans list (on the right side) shows all plans currently loaded in the attached instrument.

Upload Screen Icons:

- **Clear Plan List:** To clear the Active Plans List.
- **Upload Plans:** To transfer the list of Active plans to the novaLUM.

1. Verify that there are no data points currently in the novaLUM memory.
   - Download and save all data from memory into the database, or erase tests without saving (see “Download Data”).
2. Enter Upload Plans screen from the Main Menu/Edit or from the plans screen.
3. Click **Clear Plan List** to erase any plans previously selected in the Active Plans List.
4. Double-click on each plan name to add it to the list of plans that will be transferred to the instrument.
   - Plans will be available on the novaLUM screen in the order they are listed in the Active Plan list.
   - Remove single plans from the Active Plan list by highlighting them and pressing the Backspace key.
   - Select multiple plans in the left-hand field by holding shift key and using keyboard arrow keys or hold control key and mouse click on selected plans. Click the red arrow on the plans field to move highlighted plans to the Active Plans list for uploading.
5. Click **Upload Plans** to transfer the list of plans to the novaLUM.

When complete, a pop-up window will be displayed.
- Select OK to exit screen.
- If plans were not uploaded successfully, check to make sure instrument is connected. If problems persist, contact Charm Sciences Technical Support.
Add or Modify Channels:

- The Channel menu is used to change the name of a channel to a more familiar name for the user, or to set an overall pass/fail limit.
- Access the Channels setup screen through the Edit Menu on the main screen toolbar.
- The **instrument must be connected** before changes may be made to the channels.

Channel Screen Icons:

- **Update Unit**: Updates unit with any changes that have been made to channel name or limit.
- **Print Report**: Creates a report of all current Channels.
- **Exit**: Exits Channel screen.

Add or Modify a new Channel:

1. Connect and synchronize the instrument.
2. Click on the row of the channel to be changed. Click again to obtain a cursor.
3. Make desired changes to name. Channel names can be numbers, letters, and any of the following symbols: * / . ; # - + &. The maximum number of characters allowed is 7.
4. Click on limit field to adjust the limit (see Designing a Hygiene Testing Program for more information about setting limits).
5. Press the down arrow or tab key, or click elsewhere on the screen. Verify that the change was accepted into the database.
6. Click on the Exit icon to exit the setup screen.

If changes were made to a channel the message at left will be displayed.

- Select Yes to exit without updating instrument.
- Select No to go back and update instrument.

Calibrating a Channel:

The novalUM has a calibration routine accessed through its Main Menu “8) Calibrate” Channels selection. Refer to the novalUM operator’s manual for detailed instructions.
Download Data:

- Accessed from the Download button on the Main Screen toolbar.
- Displays and transfers all new data from the novALUM since the last download.
- Data may be viewed before being either erased or being saved to the database.
- Saved data is automatically erased from the instrument memory.
- The Download view screen may be exited without either saving or erasing data.
- Downloaded data may be periodically archived – see Archiving Data.

Download Screen Icons:

- **Save Tests**: Saves downloaded data into novaLINK database.
- **Erase Tests**: Erases downloaded data from instrument without saving to the database. **NOTE**: ERASE TESTS WILL PERMANENTLY DELETE RESULTS FROM THE NOVALUM MEMORY.
- **Exit**: Exits Download screen.

Download data to novaLINK database:

1. With the instrument connected, click on *Download*.
2. A pop-up box will appear that shows the data logged since last download. If there is no new data in novALUM to download, a message will appear stating, “There are no Assays to download.”
   - **Note**: Calibrators and controls will show a failed interpretation in the View Tests screen, but the correct interpretation will show in the Excel report files.
3. Click on *Save Tests*.
4. A message will appear warning that all data will be erased from the instrument – click OK.
   - **Note**: If the Assay Download option is set to automatically save assays upon download, it will not be necessary to click *Save Tests* and there will be no warning message.
5. After completion, click on the Exit icon to exit the Download screen.

To Erase data without downloading to novaLINK database:

1. With the instrument connected, click on *Download*.
2. Click on Erase Tests.
3. A password box will appear. The password is ‘AssayErase’.
4. A message will appear warning that all data will be erased from the instrument – click OK.
5. After completion, click on the Exit icon to exit the Download screen.
To run a default Report (containing all data from the database):

1. Click Run Report.
   - It is not necessary to select any checkboxes, all data will be included.
   - Excel will be automatically launched.
2. Macros and Automatic Refresh will need to be enabled for proper report output. Enable Macros and Enable Automatic Refresh when message boxes appear or through the security warning (Microsoft Office 2007).
3. Modify Pivot Tables and create graphs as desired (see “Report File Features”).
To filter data for a Report:

1. Choose the desired plan(s), location(s), surface(s), etc. from the column of fields at the left. If a field is blank or if the default is left unchanged, the report will show all items from that field.
   - Right-click and select Clear to uncheck all selections.
   - Use the Status drop-down to filter for data categories: pass, fail, valid, invalid, in range, out of range, calibrator.
2. Select the type of Date/Time filter (Exclude Date/Time, Use Date/Time, Use Date Only, Use Time Only).
3. Set the desired date and/or time range by typing or by using the drop-down calendar. Click elsewhere in the report screen to be sure the selection is activated.
4. Use the field selection pick lists at the right to organize the order of desired fields to be exported.
   - Field selections can be ordered in any configuration, but cannot be deleted or duplicated.
   - If the same field selection is selected more than once, an error message when Run Report button is selected “Duplicate Field Selections” and returns to the previous screen.
5. Click Run Report.
   - Excel will be automatically launched.
6. Click Enable Macros and Enable Automatic Refresh when message boxes or security warning appear.
7. Modify Pivot Tables and create graphs as desired (see “Report File Features”).

To view Plan Statistics from the report screen:

1. Set the desired date range by typing or using the drop-down calendar.
   - It is not necessary to select the type of Date/Time filter (Exclude Date/Time, etc); data will be interpreted independently of this filter.
2. Click the Plan Stats button to run the Plan Failure Rate statistical analysis.
3. Use the checkboxes to select the desired plans for the analysis.
4. Data will be grouped by week (weeks ending on Sunday) and the percentage of passing vs. failing results for tested locations from that plan will be displayed for each week within the selected date range.
5. Click Excel to generate an Excel report of this analysis, which may be printed or saved for later review.

To view Location Statistics from the report screen:

1. Set the desired date range by typing or using the drop-down calendar.
   - It is not necessary to select the type of Date/Time filter (Exclude Date/Time, etc); data will be interpreted independently of this filter.
2. Click the Location Stats button to run the Location Results statistical analysis.
3. Select the desired view from the lower-left hand corner: Re-Test View or Repetitive Failure View (see descriptions below).
4. Use the drop-down list to select the desired location for the analysis.
5. Click *Excel* to generate an Excel report of this analysis, which may be printed or saved for later review.

6. Excel reports may be generated in two ways: *Export current location* (only the currently selected location), *Export all locations* (all locations from the selected date range).

7. Notes may be added, and will be exported to Excel along with the data.

---

**Re-Test View:**

- Shows results from 12:01AM to 12:00AM (midnight) where the location, surface, plan and channel were the same.
- If the sample was retested, the retest result will be flagged as YES in the *Re-Test* column;
- If the test was not retested, the initial (failing) result will be flagged as NO.

**Repetitive Failure View:**

- Shows all results for the selected location where the location failed two or more times within the selected date range.
- Does not filter by time.
Designing a Hygiene Testing Program:

Introduction:
A hygiene testing program is composed of different test locations and surfaces within a facility. These locations and surfaces may be organized in groups called plans. In addition, there may be different assays run on the same novaLUM. Assays use different settings that are programmed on to different channels. Charm novaLINK is designed to be flexible enabling a facility to meet site-specific sanitation and HACCP requirements. Locations and surfaces may have different limits within single testing plans, and similar plans can be performed in multiple channels.

This section describes the basics for hygiene plan construction and channel selection. Refer to the novaLUM operator’s manual for further description of the instrument’s functions. For further assistance designing a sampling program or to discuss what options may best fit a specific facility, contact your local representative or Charm Sciences’ Technical Support.

Steps to create a Hygiene Testing Program:

1. Read description of limits, locations, surfaces, plans, channels and the AutoRun feature.
2. Determine what tests (assays) will be run. Are there multiple tests, requiring different channel calibrations? If so, have the channel names been uploaded into the novaLUM? (Refer to channel uploading and calibration.) Do you want to Enable or Disable the Channels? Enable channels is recommended with numerous assays and testing plans. Disable channels is recommended for fewer keystrokes, few assays and a small number of plans. (See the Additional Features section.)
3. For each test, create a list of all locations that will be tested and their associated surfaces (if applicable). This list can be subdivided into plans, which are groups of locations.
4. Determine how to organize plans. Will there be plans for different types of testing? Where are the test locations? How should these locations be grouped together: in a certain sequence along a production line, room by room, or randomly?
5. Is there any current information about test results? Can limits be assigned based on this information?

After the Hygiene Testing Program has been designed, the information can be entered into novaLINK and then uploaded to the instrument.

Limits:

- Limits are numbers that are assigned to certain locations, surface materials, or channels. This number is the cutoff point between a passing and a failing result.
- For most tests (Pesticides being the exception), a result greater than the limit will fail and a result less than or equal to the limit will pass.
- With ATP channels (LUM, AG, H2OG) the limit assigned to a channel will be overridden by a limit assigned to a surface. The limit assigned to a surface will be overridden by a limit assigned to an individual location.
- With other assay channels (AlkPhos, Somalite, CideLite, F-AP, Chef) the channel limit overrides the location or surface limit.
- If no specific limit is assigned for a location or surface, there will be a notation “-1” in the limit field. Channels limits default to “0”.

Locations:

- Locations are specific test sites. Each location may have its own limit or may be grouped with other locations with similar attributes (such as surface material or being part of the same piece of equipment/production line). The grouped locations are called a testing Plan.
- If no specific limit is assigned to a location in an ATP plan, the limit assigned to the associated surface or channel will be used.
- If the locations will not be grouped together into testing plans, the locations should be built into a list and uploaded into the instrument in the desired ‘RUN TEST’ order. (See Appendix A: Using an Instrument without using Plans.)
- Statistical analyses are available for Locations. See *To View Location Statistics* in the *Reports* section.

### Surfaces:
- Surfaces are used to describe the material of the testing location.
- Each surface may have its own cleanliness limit based upon the material (and its physical characteristics) and if it is a food-contact surface or non-food-contact surface. Critical hygiene surfaces such as food-contact stainless steel may require any detectable ATP to give a failing result. In this case a limit of “0” (zero) should be assigned to that surface.
- If no specific limit is assigned to an ATP surface, the limit assigned to the associated channel will be used. If a location has a specific limit and is associated to a certain surface, the location limit will override the surface limit.
- If the surfaces will not be grouped with locations into testing plans, the surfaces should be built into a list and uploaded into the instrument in the desired order. (See Appendix A: Using an Instrument without using Plans.)

### Plans:
- Locations and surfaces are grouped together into testing plans. The plans may be based on any desired variable, including: day on which the tests will be run, a particular production line, a particular piece of equipment, a work area.
- The plans are stored in the instrument in a certain order and may be reorganized at any time.
- Plans are associated with specific channels.
- Plans may be enabled or disabled using the Instrument Parameters window of the novaLINK main screen (see Main Screen section, Instrument Parameters Window and Additional Features section for details).

### Channels:
- Channels are calibrated to separate the different tests that can be run on the novaLUM, such as Luminescence, PasLite, Cidelite, F-AP, Chef, Somatic Cells and Giene Technology ATP applications (AllerGiene: AG and WaterGiene: H2OG). The channels may also be used to divide plans into specific groups such as the day of the week, various departments or different facilities.
- Each channel will have its own limit based on the type of test being run. The default limit of a LUM, AG or H2OG channel is “0” (zero), which means that any detectable ATP will cause a failing result. If either a specific location or surface limit has been assigned, these limits will override the channel limit.
- For PasLite, F-AP, Chef, Pesticide, and Somatic Cell applications the channel limit supercedes the location or surface limits. The default channel limits are appropriate to the assay, e.g. PasLite and F-AP: 350 mU/L, Pesticide: 0.6 x negative, Somatic Cell: 750 SCC/ml x 100.
- If the locations and surfaces will not be grouped into testing plans, the default channel for the novaLUM will activate on “Run Test” and locations will appear in the order they were uploaded into the instrument. The first loaded location will appear with the first loaded surface. The location will advance to the next loaded location with each subsequent test. (See Appendix A: Using an Instrument without using Plans.)

### AutoRun:
- This feature allows for rapid analysis of a test with minimal keystrokes. An analysis immediately starts when “Run Test” is selected from the instrument Main Menu.
- There is no visible sample screen to select and track location, surface or operator number if the AutoRun option is activated.
- The default channel and its channel limit, the first location name loaded in novaLUM, and the first surface loaded and Operator 1 are used by default. The default channel can be changed under the change preferences menu to allow the user to auto run a different test type. After analysis, the location will advance to the next location in the list of locations loaded into the instrument. Data is always compared to the channel limit.
Main Screen:

### File Menu:
- **Exit:** Closes novaLINK. This disconnects the novaLUM prior to closing the program.

### Edit Menu:
- Accesses sampling program setup screens (Channels, Surfaces, Locations, Plans and Technician List). See “Designing a Hygiene Testing Program” and “Additional Features” for more information.
- Plans setup screen may also be accessed from buttons on the Main Screen.

### View Menu:
- **Tests:** Displays all data stored in novaLINK’s database. The test points are displayed so that the oldest is at the top of the list.
- The Report function is used for more complex data analysis and filtering (See Reports).

### Setup Menu - Comport:
- Selection of the correct Comport from the drop-down list.
- This option is not accessible when an instrument is connected and synchronized to novaLINK.
- Select designated Comport that novaLUM is connected to in order to establish communication with novaLINK.

### Setup Menu - Directory:
- Selects the location of the novaLINK program and database. Most often used when selecting a networked location of novaLINK.
- Defaults to the location in which novaLINK was installed. Will automatically appear if the folder in which novaLINK is installed is renamed or moved.
- Use the novaLINK Directory Selection window to locate the folder containing the novaLINK program and database.
- A valid directory must be selected for novaLINK to run properly.

### Setup Menu - Language:
- Version 2.0 of novaLINK is only available in English.

### Setup Menu - Passwords:
- Allows the user to set up computer-specific passwords for accessing the sampling program setup screens.
- Separated into ‘Plans Passwords’ (to enter Plans screen) and ‘Other Passwords’ (to view other screens).
- The factory default/master password is “novalink” (case sensitive).
- When in password edit screens, type a new password in the box at the bottom of the screen and click “Add”. Remove an existing password by highlighting it and clicking “Remove”.
- Passwords may be enabled/disabled for the entire program; the access password for this option is “charmpass”.

### Setup Menu – Assay Download:
- Allows the user to set a preference for auto-save of downloaded data.
- If **Save Assays Upon Download** is selected, data will be automatically saved into the database.
- If **Save Assays When Save Button Is Clicked** is selected, the user will be required to click the Save or the Erase button to take the desired action.
**Setup Menu – Archive Database:**
- Allows the user to archive downloaded data into a separate database to maximize the speed of the active database.
- If the database is larger than 3000 data points, each time that novaLINK is launched the user will be asked if the database will be archived. If No is selected, the database may be archived at any time via the Setup menu.

**Reports Menu:**
- Create: Opens the Reporting screen, which is used to make a filtered report of data in the database (see Reports).
- The Reporting screen may also be accessed from the button on the Main Screen.

**Help Menu:**
- About: Displays information about novaLINK (version number, etc.).
- Contains the text of the novaLINK’s Operator’s Manual for easy referral.

**Button Toolbar:**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Update" /></td>
<td><strong>Update</strong>: Will only appear when changes have been made to the Instrument Parameters. This uploads the updated instrument parameters to the connected novaLUM.</td>
</tr>
<tr>
<td><img src="image" alt="Download" /></td>
<td><strong>Download</strong>: Displays, transfers, and erases test data from the attached novaLUM. (See Downloading Data for more information.)</td>
</tr>
<tr>
<td><img src="image" alt="Upload" /></td>
<td><strong>Upload</strong>: Transfers selected plans to the attached novaLUM. (See Uploading Plans for more information.)</td>
</tr>
<tr>
<td><img src="image" alt="Plans" /></td>
<td><strong>Plans</strong>: Opens the plans setup screen. (See Designing a Hygiene Testing Program for more information.)</td>
</tr>
<tr>
<td><img src="image" alt="Report" /></td>
<td><strong>Report</strong>: Opens the Reporting screen. (See Reports section for more information.)</td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td><strong>Exit</strong>: Closes novaLINK. It is recommended to disconnect an attached novaLUM before exiting the program (the Disconnect button is on the program Main Screen).</td>
</tr>
<tr>
<td><img src="image" alt="Disconnect" /></td>
<td><strong>Disconnect</strong>: Disconnects the novaLUM from novaLINK and automatically reboots analyzer.</td>
</tr>
</tbody>
</table>
Instrument Parameters Window:

- Displays information about the connected instrument and its customizable settings. See Additional Features section for specific details on each option.
- The Update button will appear on the Main Screen toolbar after changes are made to these parameters, and must be selected to transfer changes to the Luminometer.
- For the Customer Name, Customer Address and Site fields, left click to select field, then right-click to open an edit window. Type in new information and click OK to save. The customer and address field can accept 29 characters.
- For the Auto Run, Sample Screen, Channels and Plans fields, left click to select field, then right-click to toggle between Enable and Disable.
- For all other parameters, right-click to advance through all possible options. Each click will advance the option by one.
- See Additional Features Instrument Parameters for more information about each setting and the range of possible options.

Report File Features:

Report data is generated as an Excel file. Data which is considered Passing will be displayed with a green "Pass" interpretation. Data which is considered Failing will be displayed with a red "Fail" interpretation.

Creating a Report Template:

The Report templates window on the novaLINK Report screen contains commonly generated reports that can be opened by double-clicking on the template name. This eliminates the need to recreate the report criteria each time the report will be run.

There are two automatic report templates in novaLINK: Clear and Default. The Clear template will blank all of the Field Selections (right-hand column). The Default template opens every time the report screen is opened and contains a generic report to display all data stored in the database.

To create a new template:

1. Double-click on Clear.lst to clear all selections from the Field Selections area.
2. Right-click on each data Filter area and select Clear to remove all selections.
3. Set the desired criteria for the new report.
4. Type a name for the new template in the Report Template Name field.
5. Click Save.

The new template will appear in the list and may be opened by double-clicking on its name.

- Existing templates may be modified and re-saved with the same name.
- Templates may be deleted by right-clicking on the template name in the list and selecting Delete. The password 'novalink is required for deletion of a template.
- ‘Clear’ and ‘Default’ templates may not be deleted, though they may be modified.
Saving a report after it has been run:

An Excel report may be saved to the computer hard drive, a disc, CD or any other location.

1. The save option is only available when the file is closed. Go to the File Menu and select Close. Select YES in the next message box. Select the destination folder for the saved report and type a name for the saved report.
   - Note: DO NOT save the report as “report_English.xls” in the novaLINK reports folder. This will overwrite the base file and may cause problems with the graphs. If this is done accidentally, contact Charm Sciences or your local representative to restore the base file.
2. Once a file has been saved with a new filename, full Excel functionality is restored.

Customizing a report with a new logo, address or report column:

The logo and address on each report file may be customized.

1. Use Microsoft Windows Explorer to locate the novaLINK reports folder in the Program Files.
2. Double-click on the report file to be modified ("report_English.xls" is the English-language Excel data report).
3. DISABLE the macros and DISABLE the automatic refresh. If the automatic refresh option does not appear or the refresh cannot be disabled, do not continue. Close the file without saving and contact Charm Sciences or your local distributor for assistance.
4. Make modifications to the logo and address as desired, keeping the size of the logo and area of the address text field the same. Do not modify any other information on the sheet.
5. Save the file with exactly the same name as it originally had, and close Excel. The new logo/address will appear the next time a report is run.
   - New column(s) may also be added to the report file at this time.
6. Follow steps 1-3 above.
7. Add the new columns to the right of the existing columns. Do not insert columns between existing data columns. Save the file as instructed as in step 5 above.

Printing reports:

Any time a report is generated in Excel, the information may be printed on any printer connected to the computer. A report may also be printed from a saved file.

How to use the built-in macros:

There are three built-in macros that are supplied for graphic depiction of three sets of information: ATP counts versus date (scatter graph), All Locations from Report template vs Percent pass/fail (pie chart) and ATP counts vs location and test number (bar graph).

To generate a graph using one of these macros, click on the respective button on the first sheet of the Excel report file.

Example of pie graph.
Example of scatter graph.
Example of ATP count vs. location and test number.
**Calibrator results:**

Calibrator results are generated automatically when performing tests on any of the self-calibrating channels on the novaLUM. These calibrator test results are stored in the novaLINK database just like any other data. The calibrator results may be filtered for a report by selecting “Calibrator” in the Status area of the Report filter.

**How to use the built-in pivot tables:**

Pivot tables are interactive graphs or charts that display data in selected ways. The novaLINK Excel file has built-in pivot tables for the following sets of data:

- Percent passing and failing results, sorted by location.
- Minimum, maximum and average counts, sorted by location.
- Percent passing and failing results, sorted by location and showing limit.
- Passing/failing results for each location, expressed as a percentage of total tests run.
- Percent passing and failing results, sorted by surface.
- Minimum, maximum and average counts, sorted by surface.
- Percent passing and failing results, sorted by surface and showing limit.
- Passing/failing results for each surface, expressed as a percentage of total tests run.

The pivot tables are interactive and may be modified by selecting the arrow keys next to the listed fields. If certain data is not of interest, it can be deselected using the check boxes or custom filters. After the selections are made, press OK, and the pivot table will automatically refresh to display only selected data. If a calculated value (Maximum/Minimum/Average) is deselected from the drop down lists, the value will not be available for reselection. Generate a new report to recalculate the value.

Each pivot table has at least three filters: one on the horizontal (X) axis, one on the vertical (Y) axis, and one in the upper-left hand corner of the chart. In addition, all the power of Excel is available to change graph preferences such as color or for creating other graphics from the data.

If a report has a large number of locations or surfaces, some of the pivot tables may have so much data that they are difficult to read. The tables may be resized, but it is recommended to filter the data into more manageable reports or use the pick lists on the pivot tables to reduce the amount of data in a single view.

---

**Example of default pivot table.**

**Filter window that appears when “LOCATION” button (below chart) is selected.**

**Refreshed pivot table showing only selected locations.**
## Archiving Data:

Each downloaded data point is added to the program database. After a while, the database may become slower when running reports and viewing data due to the size of the database. If the file contains more than 3000 data points, novaLINK will prompt you to archive when the program opens. The database may be archived at any time before it reaches this size.

### Important Notes (Read prior to archiving any data):

- Archived data will no longer be available in View Tests or in Reports. It is recommended to run a report of the whole database (click Run Report on the Report Filter screen without choosing any filters) prior to archiving the database if the archived data should still be accessible.
- Archived data may be restored manually, see below.
- Archiving will not remove programmed channels, locations, surfaces, plans, technician names or any other setup options from novaLINK. All programming will remain in novaLINK when the program is reopened.

### To archive the database:

1. To manually start an archive, go to Setup and select Archive Database.
2. On Windows 2000 and NT based Operating Systems a MS-DOS or command prompt window may appear, with the message: “Overwrite….Assay.db (Yes/No/All)?” Type Y for yes then hit “Enter”.
3. A message will appear confirming that the archiving process is complete. The database will be moved to a date- and time-stamped folder underneath the Archived_Databases folder in the novaLINK directory.
4. Close and reopen novaLINK.

If there are no data to archive, the program will give a message that the Assay Table is empty.

---

### To reactivate archived data:

Once data has been archived, it may only be retrieved by manually reactivating the archived database folder.

1. Explore to the novaLINK directory. Select the folder DbData (this is the active database).
2. Right-click on the folder and select Rename. Change the name to DbData Current (or any other distinguishable name).
3. Open the folder Archived_Databases. Find the folder corresponding to the date and time of the desired archive.
4. Open the archive folder. There will be a DbData folder inside; select this folder and right-click it to select copy folder.
5. Return to the novaLINK directory and paste a copy of the archived DbData by right clicking and selecting Paste.
6. Reopen novaLINK. The archived data will be available for viewing and reporting.
7. **IMPORTANT:** When finished accessing the data, close novaLINK. Delete the DbData folder from the novaLINK directory. Rename the original DbData folder back to DbData. The program is now returned to its current state.
Additional Features:

Instrument Parameters:

- **Customer Name, Customer Addr:** Editable fields to link instrument owner information to the serial number. Right-click to open an edit window. Click OK to save changes. Click Update button to transfer changes to instrument.

- **Instrument SN:** Not editable. Pulls serial number from instrument.

- **Auto Run:** When enabled, this feature automatically initiates an analysis when “Run Test” is selected from the Main Menu. Data will be associated with “Plan0” and the first location and surface loaded into the instrument. If disabled, “Run Test” will lead to a sample screen, which allows for selection of location, surface and operator. Right-click to toggle between Enabled and Disabled. Click Update button to transfer changes to instrument.

- **Sample Screen:** When enabled, displays a screen that allows the user to select a location or sample before initiating a test under Programmed Plans. Right-click to toggle between Enabled and Disabled. Click Update button to transfer changes to instrument.

- **Channels:** When enabled, displays a list of calibrated channels and allows the user to select an appropriate channel for the type of test being analyzed. The channel list is displayed before a plan or location is selected. Enabled mainly on instruments used for several different types of tests (i.e. PocketSwab, AllerGiene and PasLite). If disabled, instrument will go directly to plan selection screen. Right-click to toggle between Enabled and Disabled. Click Update button to transfer changes to instrument.

- **Plans:** When enabled, allows the user to select a testing plan from a list. If disabled, selecting “Programmed Plans” from the instrument Main Menu will automatically go to the Sample Screen (or, if Sample Screen is disabled, will start a count). Right-click to toggle between Enabled and Disabled. Click Update button to transfer changes to instrument.

- **Test:** Editable field showing the text that is displayed on the instrument sample screen. This text may be changed to show “Oper”, “Store”, “Dept” or any other wording desired. Right-click to open an editing window. Click OK to save changes. Click Update button to transfer changes to instrument.

- **Print Style:** Shows the style of printout that the instrument will use if connected to a printer. Options are Short Ticket (3-line printout), Long Ticket (13-line printout) or 80 column (used when printing to a computer file). Right-click to toggle through the three choices. Click Update button to transfer changes to instrument.

- **Language:** Selects the instrument display language. Language choices vary depending on the connected instrument but are generally English, French, Spanish and German. Right-click to toggle through the choices. Click Update button to transfer changes to instrument.

- **Backlight:** For novaLUM, this controls the display backlight time. Range is from 0 (always on) to 255 seconds. Right-click to open an edit window. Enter desired value and click OK to save changes. Click Update button to transfer changes to instrument.

- **On Time:** Setting controlling the amount of time the instrument will remain on after a key is pressed. After this time, the instrument will beep and then shut off. Range is from 0 (never shuts off automatically) to 99 minutes. Right-click to open an edit window. Enter desired value and click OK to save changes. Click Update button to transfer changes to instrument.

- **Shuffle:** When enabled, this function will randomize test locations in the sample plans to allow the user to randomly check locations.

- **Daily Performance:** When enabled, the user will have the ability to check a negative and positive control swab to determine if the Novalum is within calibration.

- **Location Re-check:** When enabled, upon download Novalink will prompt the user if there are any failing locations that have not been retested and received passing results upon the retest.
### Location, Surface setup screens:

#### Printing lists:
Each of the elements of the database may be printed for recordkeeping.

- To print a list of all locations, surfaces, channels or technicians in the novaLINK database, go to the corresponding screen (either from the Main Screen Edit menu or from the Plan Screen Edit button) and click on the Print Report button. Excel will be opened and a list of all of the items in the database will be displayed. Note that the order of the locations or surfaces in Excel (alphabetically ordered or by database ID) will match the way that the locations or surfaces are listed in the view on the Plans screen. Also note that the first 90 surfaces will be visible in the Surfaces report; if additional surfaces are programmed into novaLINK and need to be added to the report, contact Charm Sciences.
- To print the contents of a plan, go to the Plans screen (from the button on the Main Screen or from the Edit Menu) and double-click on the plan name. Then click Print Plan. An Excel file will open showing the contents of the plan.
- These Excel files may be printed or saved under a new name. Close the file without saving changes.

### Editing existing items:
The name of a location, surface, channel or technician may be edited. Any changes to the text will update in all data already downloaded to the database. If it is desired that previously downloaded data remain the same, create a new entry in the database.

- To edit an existing item, go to the desired option (location or surface) from the Edit Menu on the toolbar. Double-click on the item to activate a cursor, and then make the desired changes. Press Enter (or Return) when done, and make sure the change is effective.
- It is not necessary to recreate a plan if a location used in that plan has been edited.
- It IS necessary to upload a list and/or reload plans to the instrument after any changes have been made to a database item.

### Technician List screen:
Technicians that will be using the instrument may each be assigned a unique ID number between 1 and 999. Up to 999 different Technician ID’s may be created. The technician’s name will be pulled into all reports when the corresponding number is selected on the instrument and a test is run.

- To add or edit a technician to the list: Enter the Technician setup screen from the Edit Menu on the toolbar. Enter the technician’s name in the name field corresponding to an ID number in the ID field. Press ENTER after the new changes have been entered.
- Click Update button to transfer changes to the novaLUM instrument.
- Clicking “Report” will open an Excel file with the entire technician list. This file may be printed or saved.

### Using a novaLUM with multiple assays:
Channel calibrations are assigned to the first 3 channels of novaLUM. Channel 1 is LUM. Channels 2 and 3 are Giene channels, and are calibrated upon request at the time of purchase. These channels will be calibrated at Charm Sciences before shipment of an instrument. The calibration settings are protected and should not be modified without specific instructions from Charm Sciences Technical Support. The other seven channels may be calibrated following the calibration procedures in the novaLUM operator’s manual and accessed through the novaLUM Main Menu 8) Calibrate Channel selection. Calibration for specific assays is required before these assays can be performed.
## Troubleshooting:

### Installation

#### Installation not completed / Program will not open
Make sure that the computer Operating System and hardware are working correctly.
- Check the version of Windows. Any version of Windows after Win 2000 should install properly.
- Check that the CD drive is working properly and that the CD is readable. Does the program install correctly on another computer?
- Installation of programs (in general) requires specific local or administrative rights and may be controlled by on-site or third party IT departments/groups.

### How to manually reinstall novaLINK

1. If a database has been downloaded to or modified, back up the current novaLINK database (dbdata) folder located where the program was installed prior to reinstallation: make a copy of the dbdata folder and then copy the archived folder from the novaLINK directory to a secure location.
2. Uninstall any previous version of novaLINK 2.0:
   - Locate the Charm Sciences folder under Start/All Programs
   - Choose novaLINK/Uninstall novaLINK.
   - For older versions of novaLINK, uninstall through Add/Remove Programs feature.
3. Explore to the CD drive.
4. Double-click on the Setup.exe file (with a computer icon) to launch the installation. Follow the normal installation steps after this point.
5. Once novaLINK has been reinstalled explore to the novaLINK folder, delete the dbdata folder, and replace it with the dbdata folder that was copied in step 1.

### Establishing Connection

#### Error message: “Instrument not compatible with this version of novaLINK”
The instrument will not connect and synchronize because it is not compatible with this version of Novalink.

#### novaLINK shuts down when I try to establish connection, or will not connect at all

- Verify that the instrument is properly connected to the cable and adapter.
- Doublecheck that the connected instrument is powered on. Plug in to wall adapter.
- Verify that the selected Comport is active and functioning.
Cannot establish a connection between the instrument and novaLINK

If you get the following Communication Error message in novaLINK this indicates the sequence of connecting to the NovaLUM instrument and software was not established correctly.

- Select OK and exit out of NovaLINK.
- Turn off and then back on the NovaLUM instrument and also reconnect the USB cable to your computer.
- Launch NovaLINK program again and try to connect.

Error message: “Unable to activate database elements”
The program is not able to find the novaLINK database.

- Close novaLINK and restart.
- Make sure that the novaLINK folder on the computer hard drive contains a “DbData” folder and that this folder contains eight database files: assay.db, channel.db, location.db, plan.db, report.db, site.db, surface.db and technician.db. There will also be several “.val” files and configuration files.
- Make sure that the user logged in to the computer has full administrative control over the folder in which the program was installed.

Error message involving “BDE” / Another database program will not open
Some databases use common Borland Database Engines to run, but only one program can be active at once. Try closing all open programs, including those which may run in the background, and then re-opening novaLINK or closing novaLINK before opening the other program.

Error message “reading data from” or “transferring data to” the novaLUM:

- Make sure that the instrument is properly connected. Turn novaLUM off and then back on.
- Close and re-open novaLINK, then reload the information.

Modifications to plans, locations, limits don’t appear in instrument:

- Make sure that the desired changes took effect in the database. If changes were saved these should be viewable.
- Verify that the changes were correctly uploaded to the instrument.

Data was erased from instrument before being saved to novaLINK:
Each instrument stores all of its data in memory and sometimes this data can be retrieved even after it has been deleted. Data can not be restored if further tests have been run after deleting the novaLUM memory. Contact your local representative or Charm Sciences for further instructions.

General Functionality

Error message when downloading involving “reading” data from the novaLUM:

- Make sure that the instrument is properly connected and that the cable is in good condition.
- Close and re-open novaLINK and retry the download operation.
- Try using the other connector/cable (USB vs. RS232/serial).
- If problems persist with an RS232 (serial port) connection, decrease the Transmit and Receive buffers on the Comport (under the Control Panel/System/Comports/Settings/Advanced window), close novaLINK and retry the download.
### Error message: “Instrument Did Not Acknowledge the Update”
- Make sure that the instrument is properly connected.
- Close and re-open novaLINK and retry the transfer.

### Only the plans from the default channel are visible
If the Channels feature is disabled, selecting the Programmed Plans option from the main screen of the instrument will list only those plans assigned to the default channel. To view all plans, activate the channels feature (see the Instrument Parameters section of Additional Features).

### The program and reports seem to be running slowly
The database may be quite large, depending on the time elapsed since installation and the amount of data stored in the database. Archive the data (see Appendix B).

### The limits are not what I thought I had set up
- Verify that there is not a location limit overriding the surface limit, or a surface limit overriding the channel limit.
- Double check that the limit is set up as intended. Click elsewhere after a change to a channel limit, to be sure that the change is made correctly in the database.

### Error Message “Operation Not Applicable”
- Verify that the instrument is connected and synchronized.
- If adding locations, surfaces or other data to the database, verify that the new additions are within the character limits specified (18 for locations, 15 for surfaces).

### Unknown Error message
Copy down the exact text of any error message that appears but is not explained in this troubleshooting section, and contact your local distributor or Charm Sciences for further assistance.

### Running Reports
#### The macros will not run:
Excel has three levels of security. The security should be set to Medium so that you have the choice to enable or disable macros in a spreadsheet. To change the security level:
1. Close the novaLINK report file (without saving it) and then open a blank Excel spreadsheet.
2. Go to the Tools menu and select Macro, then Security.
3. Select Medium as the security level (for Excel 2002, also click on the Trusted Sources tab and check the box next to the statement ”Trust Access to VB Project”).
4. Click OK, close Excel and then re-run the novaLINK report.

#### Error message “This command requires at least two rows of source data…” appears, and the report file is blank
The novaLINK report filter did not generate a report containing any data.
- Double-check that the filter options (date, time, equipment, plan, location, etc) are correctly set up.
- Verify that the data in question has been downloaded and saved in the novaLINK database: go to the View menu and select Tests. This will display a list of all tests stored in the database, oldest at the top.

#### Data that appears does not seem to match what I was looking for:
- Check that there are not two locations in the database with the same name (the program does not allow entry of duplicate items, but an item might be edited to have the same name as another).
- Use the View Tests feature to verify that the searched data is in the database.
- Verify that the template file “report_english” has not been accidentally over-written and is still a read only template (Located in C:/Program Files/novaLINK reports).
My data is not correctly interpreted (Pass/Fail):

- If tests were read using the Run Test feature of the novaLUM, they will be associated with the locations and surfaces loaded as part of the first plan. However, these tests will always be interpreted based on the Channel Limit, not the location or surface limits. This may make the interpretation appear to be incorrect if the data is compared to the surface type or location name.
- This will also affect how data is displayed in the pivot tables. Remove the data associated with Plan0 to correct this.

Printout is incomplete/List does not print

- If printing plans, check that the plan was selected and active in the bottom of the plans setup screen before "print plan" button was clicked.
- Verify that the Excel report that is generated has all the data.
- View the Excel page breaks (View -> Page Break Preview) and drag blue lines to adjust if necessary.

Error messages when going into Excel:
Copy down the exact text of any error message that appears but is not explained in this troubleshooting section, and contact your local distributor or Charm Sciences for further assistance.

Charm Sciences’ Contact Information:
Charm Sciences’ Technical Support staff can be contacted by telephone (1.978.687.9200), fax (1.978.687.9216) or e-mail (support@charm.com). Support is available by telephone 24 hours a day, 365 days a year.

LIMITED WARRANTY TERM AND CONDITIONS

1 SOFTWARE/FIRMWARE SUPPORT AND LIMITED WARRANTY
(a) Software/Firmware Limited Warranty. Commencing from the date of delivery to Customer (but in case of resale by a Charm reseller, commencing not more than ninety (90) days after original shipment by Charm), and continuing for a period of ninety (90) days the Product (if any): Charm warrants that the Charm Software and Firmware Products will substantially conform to the published specifications provided it is used with the Charm products for which it was designed. Charm also warrants that the storage media on which Software and Firmware are distributed and the accompanying documentation are free from defects in materials and workmanship. Such warranty shall not apply in the event or to the extent that data supplied by you contains errors or is improperly or incorrectly installed. During the Software/Firmware Limited Warranty period, Charm will replace defective media or documentation, or correct substantial program errors at no charge. If Charm is unable to replace defective media or documentation, or correct program errors, Charm will refund the price paid for the Software or Firmware. These are your sole remedies for any breach of warranty. Charm’s liability on any claim of any kind, whether based in contract, warranty or tort (including negligence, failure to warn or strict liability) or otherwise, for any expense, injury, loss or damage arising out of, or connected with, or resulting from the design, installation, inspection, repair, reconditioning, operation or use of any Charm Software and Firmware Products, shall be limited to the refund of the price paid for the Software or Firmware. In no event shall Charm be liable for any special, indirect or consequential damages. (b) Software/Firmware Warranty Exclusions. The above warranty shall not apply to Software and Firmware products that (1) have been altered or modified in any way without Charm’s authorization; (2) have problems resulting from interaction with software, firmware or hardware not supplied or supported by Charm; (3) have problems caused by improper or inadequate maintenance by Purchaser. (c) Software/Firmware Support Services. During the Software/Firmware Limited Warranty Period Charm, or a Charm representative designated by Charm, will provide Technical Assistance (as described below) to Purchaser to resolve issues that prevent the Software or Firmware Product from substantially conforming to its published specifications. Technical Assistance shall consist of: providing assistance in resolving documentation, installation, configuration, and usability issues; diagnosing problems and providing workarounds or fixes for known problems; diagnosing interoperability issues and providing workarounds, if possible; diagnosing new product defects and providing temporary fixes or workarounds, if possible; and characterizing newly discovered defects, initiating corrective action, and distributing the correction when available.
2 DISCLAIMER OF WARRANTY - EXCEPT AS OTHERWISE PROVIDED HEREIN, ALL CHARM HARDWARE, SOFTWARE, FIRMWARE AND DOCUMENTATION IS PROVIDED "AS IS" AND WITHOUT STATUTORY, EXPRESS OR IMPLIED WARRANTY OF ANY KIND INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND ALL WARRANTIES ARISING FROM COURSE OF DEALING OR USAGE OF TRADE.
3 MISCELLANEOUS. (a) Assignment. The Limited Warranties provided for herein are personal to the Purchaser and may not be transferred or assigned. (b) Entire Understanding; Modifications. This Limited Warranty sets forth the entire understanding of the parties regarding its subject matter, and completely supersedes and negates any other related prior or contemporaneous representations, understandings, or agreements. No change to this Limited Warranty shall be effective unless in writing and signed by an authorized Corporate Officer of Charm. (c) Governing Law; Jurisdiction and Venue. This Limited Warranty Certificate shall be governed by and construed under Massachusetts law and applicable United States federal law, without reference to "conflict of laws" principles or provisions. Jurisdiction and venue of any litigation between the parties shall lie exclusively in the courts of Essex County, Massachusetts (if in state court) or the District of Massachusetts (if in federal court).
Appendix A: Using an instrument without using plans:

- If only one type of test will be run on an instrument and if the locations do not need to be associated with surface types, analyses can be initiated using the Run Test option from the instrument Main Menu, rather than Programmed Plans.
- In this case, the instrument must be configured so that the locations and surfaces are properly activated.
- Set novaLUM default channel to the channel performing the desired analysis, e.g. LUM.

1. Open the location setup screen (from the Edit menu or from the button on the Main menu).
2. Click Clear to delete all locations from the active list (the right-hand field).
3. Add all new locations by typing or pasting the text into the active list and then clicking “Update DB”.
4. Edit the new locations’ limits as desired.
5. Select each location in turn from the Available list (left-hand field) and click on the red arrow at the bottom of the screen (between the available and active lists) to have it appear in the active list.
   - The locations will appear in the instrument in the order that they are listed in the active list.
   - Multiple locations may be selected at once. To select two or more non-consecutive locations, click on the first one and hold down the Control key and then click on the other location. To select two or more consecutive locations, click on the first location and then hold down the Shift key and press the up or down arrow on the keyboard until all the desired locations are selected.
6. Click on red arrow to move highlighted locations to the Active locations.
7. Once the Active list is organized as desired, click the Unit Update button to transfer the active list to the attached instrument.
8. Repeat for Surfaces with the knowledge that only the first loaded surface will print out in the Run Test mode.
9. Go to novaLUM and select Main Menu Item 6) Preferences. Password is ‘4000’. Find Default Channel, and select number of the channel that would be activated in the Run Test mode. For example if PasLite is Channel 4 and it is desired to run PasLite from the Run Test command, then set default channel to 4.

Example of active list.  
Example of available locations list with limits.  
Red arrow for moving items from available to active list.
Appendix B: Using novaLINK over a network:

Charm novaLINK can be installed on a networked drive and users may access the database one at a time from various local computers. In this case, there are special installation procedures for each computer/network location.

For the installation, the terms below will be used:

- Local computer: The computer which will be accessing the networked novaLINK database.
- Network computer: The location of the networked database.

During installation, select the full program installation for each computer and on the networked drive.

- **Typical**: Full program installation. Used for installation on a single computer, for non-network use. This is the default.
- **Minimal**: Installs the BDE Admin only
- **Custom**: Allows user to choose files that will be installed.

The program will be installed differently for each type of computer (local vs. network). The general procedure will be to:

1. Install the application and database on the network computer
2. Install the report files on the local computer(s)
3. Establish the link on the local computer(s) to the network database

### Installation on the network computer/server

1. Before installation, setup a shared folder with full control permissions for the groups or user names who will be accessing novaLINK from the network.
2. If the software will be installed to a network for the purpose of backing up the database, but only used on one local desktop, perform the following steps directly from that desktop.
3. Follow the installation instructions until the Setup Type screen (see above). Select *Typical*.
4. Direct the installation to the shared folder and extend the path with a child folder e.g. drive (e.g. c, f, etc.):\Shared Folder\novaLINK where **novaLINK** is the child folder.
5. Continue through the installation as prompted.
6. Connect unit to USB cable provided, then connect cable to computer, and turn unit on. *Wait until message hardware installed successfully and ready to use appears in the bottom right hand corner of the screen.* **NOTE:** If application is installed directly onto a server, it is **NOT** necessary to connect the unit to the server and install drivers, proceed to step 9.
7. Launch novaLINK from shortcut on desktop and click connect and synchronize.
8. Once connected click disconnect and the click exit to close novaLINK.
9. To install on local or individual computers; proceed to **Installation on local computer(s)** section below.
### Installation on local computer(s)

1. Follow the installation instructions until the Destination Folder screen. Browse to the shared network folder contained the previously installed novaLINK software.
2. At the Setup Type screen (see above). Select Custom
3. Click the drop down next to Application Files and change it to “This feature will not be available.” Do the same for the novaLINK database files.
4. Click the drop down next to Database Engine Files and change it to “This feature, and all subfeatures, will be installed on the local hard drive”. Do the same for novaLINK Report Files.

5. Click next, then Install, and follow through the installation.
6. Open the shared network folder. Locate the dbdata folder with the date added to the name. Rename this folder “DbData”.
7. Right-click on the novaLINK icon and choose Create a Shortcut.
8. Copy & paste the novaLINK shortcut to the desktop.
9. Connect unit to USB cable provided, then cable to computer, and turn novaLUM on. Wait until message hardware installed successfully and ready to use appears in the bottom right hand corner of the screen.

### Notes regarding network use of novaLINK:

- Only one user may access the networked novaLINK at a time.
- If one user is in the database and a second user tries to access the database, the ‘Sharing Violation’ message (at left) will appear.
- The Sharing Violation message gives information about what user (login) and which computers are accessing the database.

- If the second user requests to be notified when the database is again available for use, a program ‘novaNotify’ will run in the background of the computer, and will leave an icon open in the tray.
- When the database is ready, the message at left will appear on the screen.
- Click Yes to open novaLINK, or No to close the notification program without opening novaLINK.